HP Photosmart Plus e-All-in-One B210 series
1 HP Photosmart Plus e-All-in-One
B210 series Help

For information about the HP Photosmart, see:

- “Get to know the HP Photosmart” on page 5
- “How do I?” on page 11
- “Print” on page 17
- “Copy and scan” on page 23
- “Work with cartridges” on page 29
- “Connectivity” on page 35
- “Technical information” on page 49
- “HP support” on page 46
2 Get to know the HP Photosmart

- Printer parts
- Control panel features
- Apps Manager

Printer parts

- Front view of the HP Photosmart
1 Lid
2 Glass
3 Color graphics display (also referred to as the display)
4 Photo light
5 Memory card slots for Memory Stick and Secure Digital cards
6 Output tray
7 Paper tray extender (also referred to as the tray extender)
8 Paper-width guide for the photo tray
9 Photo tray
10 Wireless LED
11 On button
12 Lid Backing
13 Cartridge door
14 Paper-width guide for the main tray
15 Main tray (also referred to as the input tray)

- Top and rear views of the HP Photosmart
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>Printhead assembly</td>
</tr>
<tr>
<td>17</td>
<td>Cartridge access area</td>
</tr>
<tr>
<td>18</td>
<td>Model number location</td>
</tr>
<tr>
<td>19</td>
<td>Rear USB port</td>
</tr>
<tr>
<td>20</td>
<td>Power connection (Use only with the power adapter supplied by HP.)</td>
</tr>
<tr>
<td>21</td>
<td>Rear door</td>
</tr>
</tbody>
</table>
Control panel features

Figure 2-1 Control panel features

1. **Home**: Returns to the Homescreen (the default screen when you turn on the product).
2. **Directional keys**: Allow you to navigate through photos and menu options. Touch the right arrow button to access the secondary Home screen.
3. **Back**: Returns to the previous screen on the display.
4. **Photo**: Opens the Photo menu.
5. **Copy**: Opens the Copy menu where you can select a copy type or change the copy settings.
6. **Scan**: Opens the Scan To menu where you can select a destination for your scan.
7. **Cancel**: Stops the current operation.
8. **Help**: Opens the Help menu on the display where you can select a topic to learn more about it. From the Home screen, touching Help lists the topics for which help is available. Depending on the topic you select, the topic will appear on the display or on your computer screen. When viewing screens other than the Home screen, the Help button provides help applicable to the current screen.
9. **Setup**: Opens the Setup menu where you can change product settings and perform maintenance functions.
10. **Snapfish**: Opens Snapfish where you can upload, edit, and share your photos. Snapfish may not be available depending on your country/region.
11. **Apps**: Apps provides a quick and easy way to access and print information from the Web, such as maps, coupons, coloring pages, and puzzles.
12. **Network Menu**: Opens the wireless menu where you can change the wireless settings.
13. **HP ePrint**: Opens the HP ePrint menu where you can turn the service on or off, display the printer email address, and print an information page.

**Apps Manager**

The Apps Manager can be used to add new Apps or to remove Apps.
Manage Apps

▲ Add new Apps.

a. Touch Apps on the home screen.

b. Press the directional keys to scroll to the More menu option. Press OK. Check desired Apps. Press OK. Follow prompts.
How do I?

This section contains links to commonly performed tasks, such as printing photos, scanning, and making copies.

“Apps Manager” on page 8
“Replace the cartridges” on page 29
“Load media” on page 13
“Scan to a computer” on page 23
“Copy text or mixed documents” on page 24
“Clear the paper jam from the rear access door” on page 42
Load media

Do one of the following:

Load 10 x 15 cm (4 x 6 inch) paper

a. Raise photo tray lid.
   Raise photo tray lid and slide paper-width guide outwards.

b. Load paper.
   Insert stack of photo paper into photo tray with short edge forward and print side down.

Slide stack of paper forward until it stops.

**NOTE:** If the photo paper you are using has perforated tabs, load photo paper so that tabs are closest to you.

Slide paper-width guide inward until it stops at edge of paper.
c. Lower photo tray lid.

Load A4 or 8.5 x 11 inch paper

a. Raise output tray.
   - Raise and hold output tray in open position.
   - Slide paper-width guide outwards.
   - Remove all paper from the main input tray.

b. Load paper.
   - Insert stack of paper into main input tray with short edge forward and print side down.
Slide stack of paper forward until it stops. Slide paper-width guide inward until it stops at edge of paper.

**c.** Lower output tray.

Lower output tray and pull tray extender towards you, as far as it will go. Flip paper catch at end of tray extender.

**NOTE:** When you use legal-size paper, leave the paper catch closed.

**Load envelopes**

a. Raise output tray.

Raise and hold output tray in open position. Slide paper-width guide outwards. Remove all paper from the main input tray.

b. Load envelopes.

Insert one or more envelopes into far-right side of main input tray, with envelope flaps on left and facing up.
Slide stack of envelopes forward until it stops.
Slide paper-width guide inward against stack of envelopes until it stops.

C. Lower output tray.
5 Print

“Print documents” on page 17

“Print photos” on page 18

“Print envelopes” on page 19

“Print from anywhere” on page 19

Related topics
“Load media” on page 13
“Print from anywhere” on page 19
“Tips for print success” on page 20

Print documents

Most print settings are automatically handled by the software application. You need to change the settings manually only when you change print quality, print on specific types of paper or transparency film, or use special features.

To print from a software application
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. If you need to change settings, click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.

NOTE: When printing a photo, you must select options for the specific photo paper and photo enhancement.
5. Select the appropriate options for your print job by using the features available in the Advanced, Printing Shortcuts, Features, and Color tabs.

**TIP:** You can easily select the appropriate options for your print job by choosing one of the predefined print tasks on the Printing Shortcuts tab. Click a type of print task in the Printing Shortcuts list. The default settings for that type of print task are set and summarized on the Printing Shortcuts tab. If necessary, you can adjust the settings here and save your custom settings as a new printing shortcut. To save a custom printing shortcut, select the shortcut and click Save As. To delete a shortcut, select the shortcut and click Delete.

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.

Related topics
- “Load media” on page 13
- “Tips for print success” on page 20

Print photos

“Print photos saved on your computer” on page 18

Print photos saved on your computer

To print a photo on photo paper
1. Load up to 13 x 18 cm (5 x 7 inch) paper in the photo tray or full-size photo paper in the main input tray.
2. Slide the paper-width guide inward until it stops at the edge of the paper.
3. On the File menu in your software application, click Print.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
6. Click the Features tab.
7. In the Basic Options area, from the Paper Type drop-down list, select More. Then, select the appropriate photo paper type.
8. In the Resizing Options area, from the Size drop-down list, select More. Then, select the appropriate paper size.
   If the paper size and paper type are not compatible, the printer software displays an alert and allows you to select a different type or size.
9. (Optional) Select the **Borderless printing** check box if it is not already checked. If the borderless paper size and paper type are not compatible, the product software displays an alert and allows you to select a different type or size.

10. In the **Basic Options** area, select a high print quality, such as **Best**, from the **Print Quality** drop-down list.

    **NOTE:** To achieve the highest dpi resolution, you can use the **Maximum dpi** setting with supported types of photo paper. If **Maximum dpi** is not listed in the Print quality drop-down list, you can enable it from the **Advanced** tab.

    **NOTE:** Do not leave unused photo paper in the input tray. The paper might start to curl, which could reduce the quality of your printout. For best results, do not allow printed photos to stack up in the output tray.

Related topics
- “Load media” on page 13
- “Tips for print success” on page 20

### Print envelopes

With the HP Photosmart, you can print on a single envelope, a group of envelopes, or label sheets designed for inkjet printers.

**To print a group of addresses on labels or envelopes**

1. Print a test page on plain paper first.
2. Place the test page on top of the label sheet or envelope, and hold both up to the light. Check the spacing for each block of text. Make adjustments as needed.
3. Load the labels or envelopes into the paper tray.

    **CAUTION:** Do not use envelopes with clasps or windows. They can get stuck in the rollers and cause paper jams.

4. Slide the paper-width guide inward against the stack of labels or envelopes until the guide stops.
5. If you are printing on envelopes, do the following:
   
a. Display the print settings, and click the **Features** tab.
   
b. In the **Resizing Options** area, click the appropriate envelope size in the **Size** list.
6. Click **OK**, and then click **Print** or **OK** in the **Print** dialog box.

Related topics
- “Load media” on page 13
- “Tips for print success” on page 20

### Print from anywhere

The **HP ePrint** feature on your product provides convenience printing that allows you to print from anywhere. Once enabled, **HP ePrint** assigns an email address to your product.
To print, simply send an email containing your document to that address. You can print images, Word, PowerPoint, and PDF documents. It's easy!

**NOTE:** Documents printed with HP ePrint may appear different from the original. Style, formatting, and text flow may differ from the original document. For documents that need to be printed with a higher quality (such as legal documents), we recommend that you print from the software application on your computer, where you will have more control over what your printout looks like.

To print a document from anywhere
1. Find your HP ePrint email address.
   a. Touch the Web Service icon on the Home screen.
   b. Touch Display Email Address.

   **TIP:** To print the email address or registration url, touch Print Info Sheet on the Web Services Settings menu.

2. Compose and send email.
   a. Create a new email and type the product email address in the To box.
   b. Type text in the body of the email and attach the documents or images that you want to print.
   c. Send the email.

   The product prints your email.

   **NOTE:** To receive email, your product must be connected to the Internet. Your email will print as soon as it is received. As with any email, there is no guarantee when or if it will be received. When you register online with HP ePrint, you can check the status of your jobs.

**Tips for print success**

Use the following tips to print successfully.

**Print tips**

- Use genuine HP cartridges. Genuine HP cartridges are designed for and tested with HP printers to help you produce great results, time after time.
- Make sure the cartridges have sufficient ink. To check the estimated ink levels, follow the instruction in the Tools menu on the display. Alternatively, you can check the ink levels in Printer Toolbox from the software.
- Load a stack of paper, not just one page. Use clean and flat paper of the same size. Make sure only one type of paper is loaded at a time.
- Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width guide does not bend the paper in the input tray.
- Set the print quality and paper size settings according to the type and size of paper loaded in the input tray.
- Use print preview to check margins. Do not let the margin settings for the document exceed the printable area of the printer.
• Learn how to share your photos online and order prints. Click here to go online for more information.
• Learn about Apps Manager for printing recipes, coupons, and other content from the web, simply and easily. Click here to go online for more information.
• Learn how to print from anywhere by sending an email and attachments to your printer. Click here to go online for more information.

HP ePrint tips
• To reduce spam, try the following:
  ◦ Register online with HP ePrint and restrict who can email your printer.
    To print the email address or registration url, touch Print Info Sheet on the Web Services Settings menu.
  ◦ Don't use the product's email address to register for other online sites.
  ◦ Don't include the product's email address on distribution lists.
  ◦ If spam becomes an issue, you can reset the product's email address.
    To reset the email address, touch the Web Service icon on Home screen. Touch Reset Email Address.
• HP ePrint supports the following file types as attachments:
  ◦ Microsoft Word (doc, docx)
  ◦ Microsoft PowerPoint (ppt, ppx)
  ◦ PDF
  ◦ HTML
  ◦ Certain image files (bmp, jpg, png, gif, and tiff)
  ◦ Text-based files
• Documents printed with HP ePrint may appear different from the original:
  ◦ Style, formatting, and text flow may differ from the original document.
  ◦ For documents that need to be printed with a higher quality (such as legal documents), we recommend that you print from the software application on your computer, where you will have more control over what your printout looks like.
• To receive email, your product must be connected to the Internet.
  ◦ Your email will print as soon as it is received.
  ◦ As with any email, there is no guarantee when or if it will be received.
  ◦ When you sign up online with HP ePrint, you can check the status of your jobs.
6 Copy and scan

- Scan to a computer
- Copy text or mixed documents
- Tips for copy and scan success

Scan to a computer

To scan to a computer
1. Load original.
   a. Lift lid on product.
   b. Load original print side down on right front corner of glass.
c. Close lid.

2. Start scan.
   a. Touch **Scan** on Home screen.
      The **Scan To** menu appears.
   b. Touch **Computer**.
      If product is network-connected, a list of available computers appears. Select computer to which you want to transfer to start the scan.

3. Touch job shortcut you want to use.
4. Touch Start Scan.

**Related topics**
“**Tips for copy and scan success**” on page 27

**Copy text or mixed documents**

▲ Do one of the following:

**Make a black and white copy**

a. Load paper.
   Load full-size paper in main input tray.

b. Load original.
   Lift lid on product.
**TIP:** To make copies of thick originals, such as books, you can remove the lid.

Load original print side down on right front corner of glass.

Close lid.

c. Select Copy.
   - Touch **Copy** on Home screen.
   - The **Copy** menu appears.
   - Touch up arrow to increase number of copies.
   - Touch **Settings**.
   - The **Copy Settings** menu appears.
   - Touch **Size**.
   - Touch **Fit to Page**.

d. Start copy.
   - Touch **Black Copy**.

**Make a color copy**

a. Load paper.
   - Load full-size paper in main input tray.

b. Load original.
   - Lift lid on product.
To make copies of thick originals, such as books, you can remove the lid.

Load original print side down on right front corner of glass.

**TIP:**

1. Load original print side down on right front corner of glass.
2. Close lid.
3. Select Copy.
   - Touch Copy on Home screen.
   - The Copy menu appears.
   - Touch up arrow to increase number of copies.
   - Touch Settings.
   - The Copy Settings menu appears.
   - Touch Size.
   - Touch Fit to Page.
4. Start copy.
   - Touch Color Copy.

**Related topics**
- “Load media” on page 13
- “Tips for copy and scan success” on page 27
Tips for copy and scan success

Use the following tips to copy and scan successfully:

• Learn how to scan when your printer is on a wireless network and not nearby your computer. Click here to go online for more information.

• Keep the glass and the back of the lid clean. The scanner interprets anything it detects on the glass as part of the image.

• Load your original, print side down, on the right front corner of the glass.

• To copy or scan a book or other thick originals, remove the lid.

• To make a large copy of a small original, scan the original into the computer, resize the image in the scanning software, and then print a copy of the enlarged image.

• To avoid incorrect or missing scanned text, make sure the brightness is set appropriately in the software.

• If the scanned image is incorrectly cropped, turn off the autocropping feature in the software and crop the scanned image manually.
7 Work with cartridges

- Replace the cartridges
- Cartridge warranty information
- Order ink supplies
- Clean printhead automatically
- Check the estimated ink levels
- Tips for working with ink

Replace the cartridges

To replace the cartridges
1. Check that power is on.
2. Remove cartridge.
   a. Open cartridge access door.

3. Insert new cartridge.
   a. Remove cartridge from packaging.

Wait for print carriage to move to center of product.

b. Press tab on cartridge, then remove it from slot.
b. Twist orange cap to snap it off. A forceful twist may be required to remove cap.

c. Match color icons, then slide cartridge into slot until it clicks into place.

d. Close cartridge door.
Cartridge warranty information

The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty date has not been reached. The end of warranty date, in YYYY/MM format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the product.

Order ink supplies

To order genuine HP supplies for the HP Photosmart, go to www.hp.com/buy/supplies. If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.
Clean printhead automatically

To clean the printhead from the printer display
1. From the Home screen, touch the Setup icon. The Setup Menu is displayed.
2. Touch Tools.
3. Touch Clean Printhead.

Related topics
“Order ink supplies” on page 31
“Tips for working with ink” on page 33

Check the estimated ink levels

You can easily check the ink supply level to determine how soon you might need to replace a cartridge. The ink supply level shows an estimate of the amount of ink remaining in the cartridges.

**NOTE:** If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another printer, the ink level indicator might be inaccurate or unavailable.

**NOTE:** Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not have to replace the cartridges until the print quality is unacceptable.

**NOTE:** Ink from the cartridges is used in the printing process in a number of different ways, including in the initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it is used. For more information, see www.hp.com/go/inkusage.

To check the ink levels from the control panel
1. From the Home screen, touch the Setup icon. The Setup Menu is displayed.
2. Touch Tools.
3. Touch Display Estimated Ink Levels.
   The HP Photosmart displays a gauge that shows the estimated ink levels of all cartridges installed.
To check the ink levels from the Printer Software

1. Click the HP Photosmart desktop icon to open the Printer Software.

   
   **NOTE:** You can also access the Printer Software by clicking **Start > Programs > HP > HP Photosmart Plus B210 > HP Photosmart Plus B210**

2. In the Printer Software, click **Estimated Ink Levels**.

Related topics

“Order ink supplies” on page 31
“Tips for working with ink” on page 33

Tips for working with ink

Use the following tips to work with ink cartridges:

- Use the correct ink cartridges for your printer. For a list of compatible ink cartridges, look in **Printer Toolbox** in the software.
- Insert the ink cartridges into the correct slots. Match the color and icon of each cartridge to the color and icon for each slot. Make sure all cartridges snap down into place.
- Use genuine HP ink cartridges. Genuine HP ink cartridges are designed for and tested with HP printers to help you produce great results, time after time.
- Consider getting replacement ink cartridges when you receive an ink alert message. This avoids possible printing delays. You do not need to replace the ink cartridges until print quality becomes unacceptable.
- Make sure the printhead is clean. Follow the instructions from **Tools** menu on the printer display. Alternatively, look in **Printer Toolbox** in the software.
- After you insert new ink cartridges, align the printer for best print quality. Follow the instructions from **Tools** menu on the printer display. Alternatively, look in **Printer Toolbox** in the software.

   **NOTE:** To access the **Printer Toolbox** in the Printer Software open the Printer Software, click **Printer Actions** and then click **Maintenance Tasks**.
8 Connectivity

- Add the HP Photosmart to a network
- Tips for setting up and using a networked printer

Add the HP Photosmart to a network

- “WiFi Protected Setup (WPS)” on page 35
- “Wireless with a router (infrastructure network)” on page 36
- “Wireless without a router (ad hoc connection)” on page 37

WiFi Protected Setup (WPS)

To connect the HP Photosmart to a wireless network using WiFi Protected Setup (WPS), you will need the following:

A wireless 802.11 network that includes a WPS-enabled wireless router or access point.
A desktop computer or laptop with either wireless networking support, or a network interface card (NIC). The computer must be connected to the wireless network that you intend to install the HP Photosmart on.

To connect the HP Photosmart using WiFi Protected Setup (WPS)

▲ Do one of the following:

Use Push Button (PBC) method

a. Select setup method.
   On Home screen, touch the Wireless icon.
   Touch Wireless Settings.
   Touch WiFi Protected Setup.
   Touch Push Button.

b. Set up wireless connection.
   Press corresponding button on WPS-enabled router or other networking device.
   Touch OK.

c. Install software.

NOTE: The product begins a timer for approximately two minutes in which the corresponding button on the networking device needs to be pressed.

Use PIN method

a. Select setup method.
   On Home screen, touch the Wireless icon.
   Touch Wireless Settings.
Connectivity

Chapter 8

Wireless with a router (infrastructure network)

To connect the HP Photosmart to an integrated wireless WLAN 802.11 network, you will need the following:

- A wireless 802.11 network that includes a wireless router or access point.
- A desktop computer or laptop with either wireless networking support, or a network interface card (NIC). The computer must be connected to the wireless network that you intend to install the HP Photosmart on.
- Broadband Internet access (recommended) such as cable or DSL.

If you connect the HP Photosmart on a wireless network that has Internet access, HP recommends that you use a wireless router (access point or base station) that uses Dynamic Host Configuration Protocol (DHCP).

- Network name (SSID).
- WEP key or WPA Passphrase (if needed).

To connect the product with the Wireless Setup Wizard

1. Write down your network name (SSID) and WEP key or WPA passphrase.
   ▲ Touch Wireless Setup Wizard.
3. Connect to wireless network.
   ▲ Select your network from the list of detected networks.
4. Follow prompts.
5. Install software.
6. View the animation for this topic.

Related topics

- “Install the software for a network connection” on page 39
- “Tips for setting up and using a networked printer” on page 40
Wireless without a router (ad hoc connection)

Use this section if you want to connect the HP Photosmart to a wireless-capable computer without using a wireless router or access point.

There are two methods you can use to connect the HP Photosmart to your computer using an ad hoc wireless network connection. Once connected, you can install the HP Photosmart software.

Turn on the wireless radio for the HP Photosmart and the wireless radio on your computer. On your computer, connect to the network name (SSID) hp (product model).(6-digit unique identifier), which is the default ad hoc network created by the HP Photosmart. The 6-digit identifier is unique to each printer.

**OR**

Use an ad hoc network profile on your computer to connect to the product. If your computer is not currently configured with an ad hoc network profile, consult the Help file for your computer Operating System for the proper method to create an ad hoc profile on your computer. Once the ad hoc network profile has been created, insert the installation CD that came with the product and install the software. Connect to the ad hoc network profile you created on your computer.

**NOTE:** An ad hoc connection can be used if you do not have a wireless router or access point but do have a wireless radio on your computer. However, an ad hoc connection may result in a lower level of network security and possibly reduced performance when compared to an infrastructure network connection using a wireless router or access point.

To connect the HP Photosmart to a Windows computer with an ad hoc connection, the computer must have a wireless network adapter and an ad hoc profile. Create a network profile for a Windows Vista or Windows XP computer using the directions below.

**NOTE:** The product comes configured with a network profile with hp (product model).(6-digit unique identifier) as the network name (SSID). However, for security and privacy HP recommends you create a new network profile on your computer as described here.
To create a network profile (Windows Vista)

**NOTE:** The product comes configured with a network profile with **hp (product model).(6-digit unique identifier)** as the network name (SSID). However, for security and privacy HP recommends you create a new network profile on your computer as described here.

1. In the **Control Panel**, double-click **Network and Internet**, then **Network and Sharing Center**.
2. In the **Network and Sharing Center** (under **Tasks** on the left), select **Set up a connection or network**.
3. Choose the connection option **Set up a wireless ad hoc (computer-to-computer) network**, then click **Next**. Read the description and warnings about ad hoc networks, then click **Next>**.
4. Enter details, including **Network name** (the SSID for your ad hoc connection), **Security type**, and **SecurityPassphrase**. If you are going to save this network connection, check **Save this network**. Make a note of the SSID and the Security key/Passphrase for future reference. Click **Next**.
5. Continue to follow the prompts to complete setup of the ad hoc network connection.

To create a network profile (Windows XP)

**NOTE:** The product comes configured with a network profile with **hp (product model).(6-digit unique identifier)** as the network name (SSID). However, for security and privacy HP recommends you create a new network profile on your computer as described here.

1. In the **Control Panel**, double-click **Network Connections**.
2. On the **Network Connections** window, right-click the **Wireless Network Connection**. If you see **Enable** on the pop-up menu, select it. Otherwise, if you see **Disable** on the menu, the wireless connection is already enabled.
3. Right-click the **Wireless Network Connection** icon, and then click **Properties**.
4. Click the **Wireless Networks** tab.
5. Select the **Use Windows to configure my wireless network settings** check box.
6. Click **Add**, and then do the following:
   a. In **Network name (SSID)** box, type in a unique network name of your choice.

**NOTE:** The network name is case sensitive, so it is important to remember any uppercase (capital) and lowercase (small) letters.

   b. If there is a **Network Authentication** list, select **Open**. Otherwise, go to the next step.

   c. In the **Data encryption** list, select **WEP**.

   d. Make sure that the check box is not selected next to **The key is provided for me automatically**. If it is selected, click the check box to clear it.
e. In the **Network key** box, type a WEP key that has **exactly** 5 or **exactly** 13 alphanumeric (ASCII) characters. For example, if you enter 5 characters, you might enter **ABCDE** or **12345**. Or, if you enter 13 characters, you might enter **ABCDEF1234567**. (12345 and ABCDE are examples only. Select a combination of your choosing.)

Alternatively, you can use HEX (hexadecimal) characters for the WEP key. A HEX WEP key must be 10 characters for 40 bit encryption, or 26 characters for 128 bit encryption.

f. In the **Confirm network key** box, type the same WEP key you typed in the previous step.

NOTE: You must remember the exact uppercase (capital) and lowercase (small) letters. If you enter your WEP key incorrectly on the product, the wireless connection will fail.

g. Write down the WEP key exactly as you typed it, including uppercase and lowercase letters.

h. Select the check box for **This is a computer-to-computer (ad hoc) network; wireless access points are not used**.

i. Click **OK** to close the **Wireless network properties** window, and then click **OK** again.

j. Click **OK** again to close the **Wireless Network Properties Connection** window.

Related topics

“Install the software for a network connection” on page 39
“Tips for setting up and using a networked printer” on page 40

**Install the software for a network connection**

Use this section to install the HP Photosmart software on a computer connected to a network. Before you install the software, make sure you have connected the HP Photosmart to a network. If the HP Photosmart has not been connected to a network, follow the onscreen instructions during the software installation to connect the product to the network.

**To install the Windows HP Photosmart Software on a networked computer**

1. Quit all applications running on your computer.
2. Insert the Windows CD that came with the product into the CD-ROM drive on your computer and follow the onscreen instructions.

NOTE: If you will use the HP Photosmart over a wireless network connection and it is not connected to a network, you will be prompted to run the Wireless Setup Wizard from the product’s front panel before continuing the software installation. If you don’t know your wireless settings the software can help find them for you.

NOTE: Some products require a temporary USB cable connection to make a wireless network connection. The software will prompt you when to make this temporary connection if it is required.
3. If a dialog box about firewalls appears, follow the instructions. If you see firewall pop-up messages, you must always accept or allow the pop-up messages.

4. On the **Connection Type** screen, select the Network option, and then click **Next**. If the HP Photosmart supports both wireless and wired (Ethernet) network connections, you will also be prompted to choose between **Wireless** and **Wired**. The **Searching** screen appears as the Setup program searches for the product on the network. If the HP Photosmart will use a temporary USB cable connection to setup a wireless connection and this is a first time install of the HP Photosmart, you will be prompted to connect the USB cable after the network search is performed.

5. On the **Printer Found** screen, verify that the printer description is correct and then select it.
   If more than one printer is found on the network, the **Printers Found** screen appears. Select the product you want to connect. You can identify the printer by model number, IP address, serial number or MAC address.

6. Follow the prompts to install the software.
   When you have finished installing the software, the product is ready for use.

7. To test your network connection, go to your computer and print a self-test report to the printer. The wireless light on the printer should be ON and steady. A BLINKING light indicates there is no network connection. If the wireless light is OFF it means the wireless radio is not ON. Printing a Wireless Network Test report from the printer’s front panel can help identify any problems.

### Tips for setting up and using a networked printer

Use the following tips to set up and use a networked printer:

- When setting up the wireless networked printer, make sure your wireless router or access point is powered on. The printer searches for wireless routers, then lists the detected network names on the display.

- To verify the wireless connection, check the wireless radio light in the **Wireless Settings** menu on the display. If the light is off, select **Enable Wireless** to enable the wireless connection. It also displays the IP address of the printer.

- If your computer is connected to a Virtual Private Network (VPN), you need to disconnect from the VPN before you can access any other device on your network, including the printer.

- Learn how to find your network security settings. [Click here to go online for more information.](#)

- Learn about the Network Diagnostic Utility and other troubleshooting tips. [Click here to go online for more information.](#)

- Learn how to change from a USB to wireless connection. [Click here to go online for more information.](#)

- Learn how to work with your firewall and anti-virus programs during printer setup. [Click here to go online for more information.](#)
9 Solve a problem

This section contains the following topics:

- Get more help
- Improve print quality
- Clear the paper jam from the rear access door
- Unable to print
- HP support

Get more help

You can find more information and help about your HP Photosmart by entering a keyword in the Search field in the top left of the help viewer. Titles of related topics -- for both local and online topics -- will be listed.

Click here to go online for more information.

Improve print quality

1. Make sure you are using genuine HP cartridges.
2. Check the Printer Software settings to make sure you have selected the appropriate paper type and print quality from the Media drop-down list.
3. Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see “Check the estimated ink levels” on page 32. If the print cartridges are low on ink consider replacing them.
4. Align the printer cartridges.

To align the cartridges from the Printer Software

>Note: Aligning the cartridges ensures high-quality output.

a. Load letter or A4 unused plain white paper into the input tray.
b. In the Printer Software, click Printer Actions and then click Maintenance Tasks to access the Printer Toolbox.
c. The Printer Toolbox appears.
d. Click the Device Services tab.
e. Click Align Ink Cartridges tab. The product prints an alignment sheet.
5. Print a diagnostics page if the cartridges are not low on ink.

To print a diagnostics page

a. Load letter or A4 unused plain white paper into the input tray.
b. In the Printer Software, click Printer Actions and then click Maintenance Tasks to access the Printer Toolbox.
c. Click Print Diagnostic Information to print a diagnostics page. Review the blue, magenta, yellow, and black boxes on the diagnostics page. If you are seeing
streaks in the color and black boxes, or no ink in portions of the boxes, then automatically clean the cartridges.

6. Clean the print cartridges automatically, if the diagnostic page shows streaks or missing portions of the color and black boxes.

To clean the cartridges automatically
a. Load letter or A4 unused plain white paper into the input tray.
b. In the Printer Software, click Printer Actions and then click Maintenance Tasks to access the Printer Toolbox.
c. Click Clean Ink Cartridges. Follow the onscreen instructions.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Clear the paper jam from the rear access door

To clear a paper jam from the rear access door
1. Turn product off.
2. Remove rear door.
3. Remove jammed paper.
4. Replace rear door.

5. Turn on product.
6. Try printing again.

Unable to print

Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to print, try the following in order:

1. Check for error messages and resolve.
2. Disconnect and reconnect the USB cable.
3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline

**NOTE:** HP provides a Printer Diagnostic Utility that can automatically fix this issue.

Click [here](#) to go online for more information. Otherwise, follow the steps below.

a. Depending upon your operating system, do one of the following:
   - **Windows 7:** From the Windows Start menu, click Devices and Printers.
   - **Windows Vista:** From the Windows Start menu, click Control Panel, and then click Printers.
   - **Windows XP:** From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Double-click the icon for your product to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer Offline.

d. If you made any changes, try to print again.
4. Verify that the product is set as the default printer.

To verify that the product is set as the default printer

NOTE: HP provides a Printer Diagnostic Utility that can automatically fix this issue.

Click here to go online for more information. Otherwise, follow the steps below.

a. Depending upon your operating system, do one of the following:
   • Windows 7: From the Windows Start menu, click Devices and Printers.
   • Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
   • Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Make sure the correct product is set as the default printer.
The default printer has a check mark in a black or green circle next to it.
c. If the wrong product is set as the default printer, right-click the correct product and select Set as Default Printer.
d. Try using your product again.

5. Restart the print spooler.

To restart the print spooler

NOTE: HP provides a Printer Diagnostic Utility that can automatically fix this issue.

Click here to go online for more information. Otherwise, follow the steps below.

a. Depending upon your operating system, do one of the following:

Windows 7
   • From the Windows Start menu, click Control Panel, System and Security, and then Administrative Tools.
   • Double-click Services.
   • Right-click the Print Spooler, and then click Properties.
   • On the General tab, next to Startup type, make sure that Automatic is selected.
   • If the service is not already running, under Service status, click Start, and then click OK.

Windows Vista
   • From the Windows Start menu, click Control Panel, System and Maintenance, Administrative Tools.
   • Double-click Services.
• Right-click the Print Spooler service, and then click Properties.
• On the General tab, next to Startup type, make sure that Automatic is selected.
• If the service is not already running, under Service status, click Start, and then click OK.

Windows XP
• From the Windows Start menu, right click My Computer.
• Click Manage, and then click Services and Applications.
• Double-click Services, and then select Print Spooler.
• Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct product is set as the default printer.
The default printer has a check mark in a black or green circle next to it.
c. If the wrong product is set as the default printer, right-click the correct product and select Set as Default Printer.
d. Try using your product again.

6. Restart the computer.
7. Clear the print queue.

To clear the print queue

NOTE: HP provides a Printer Diagnostic Utility that can automatically fix this issue.

Click here to go online for more information. Otherwise, follow the steps below.

a. Depending upon your operating system, do one of the following:
• Windows 7: From the Windows Start menu, click Devices and Printers.
• Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
• Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Double-click the icon for your product to open the print queue.
c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to confirm.
d. If there are still documents in the queue, restart the computer and try printing again after the computer has restarted.
e. Check the print queue again to make sure it is clear, and then try to print again.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Clear the print carriage

Remove any objects, such as paper, that are blocking the print carriage.
**NOTE:** Do not use any tools or other devices to remove jammed paper. Always use caution when removing jammed paper from inside the product.

Click here to go online for more information.

**Resolve copy and scan issues**

Click here to go online for more information.

**HP support**

- Register the product
- HP support by phone
- Additional warranty options

**Register the product**

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product support alerts. If you did not register your printer while installing the software, you can register now at [http://www.register.hp.com](http://www.register.hp.com).

**HP support by phone**

Phone support options and availability vary by product, country/region, and language. This section contains the following topics:

- Phone support period
- Placing a call
- After the phone support period

**Phone support period**

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to [www.hp.com/support](http://www.hp.com/support). Standard phone company charges apply.

**Placing a call**

Call HP support while you are in front of the computer and the product. Be prepared to provide the following information:

- Product name (HP Photosmart Plus e-All-in-One B210 series)
- Serial number (located on the back or bottom of the product)
- Messages that appear when the situation occurs
- Answers to these questions:
  - Has this situation happened before?
  - Can you re-create it?
Did you add any new hardware or software to your computer at about the time that this situation began?

Did anything else occur prior to this situation (such as a thunderstorm, product was moved, etc.)?

For the list of support phone numbers, visit www.hp.com/support.

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help may also be available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call the support phone number for your country/region to learn more about support options.

Additional warranty options

Extended service plans are available for the HP Photosmart at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the services and warranty area for information about the extended service plans.
10 Technical information

The technical specifications and international regulatory information for the HP Photosmart are provided in this section.
For additional specifications, see the printed documentation that came with the HP Photosmart.
This section contains the following topics:

• Notice
• Cartridge chip information
• Specifications
• Environmental product stewardship program
• Regulatory notices
• Regulatory wireless statements

Notice

Hewlett-Packard Company notices

The information contained in this document is subject to change without notice. All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior written permission of Hewlett-Packard, except as allowed under copyright laws. The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. © 2009 Hewlett-Packard Development Company, L.P.

Microsoft, Windows, Windows XP, and Windows Vista are U.S. registered trademarks of Microsoft Corporation. Windows 7 is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Cartridge chip information

The HP cartridges used with this product contain a memory chip that assists in the operation of the product. In addition, this memory chip collects a limited set of information about the usage of the product, which might include the following: the date when the cartridge was first installed, the date when the cartridge was last used, the number of pages printed using the cartridge, the page coverage, the printing modes used, any printing errors that might have occurred, and the product model. This information helps HP design future products to meet our customers printing needs.

The data collected from the cartridge memory chip does not contain information that can be used to identify a customer or user of the cartridge or their product.

HP collects a sampling of the memory chips from cartridges returned to HP’s free return and recycling program (HP Planet Partners: www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The memory chips from this sampling are read and studied in order to improve future HP products. HP partners who assist in recycling this cartridge might have access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous information on the memory chip. If you prefer to not allow access to this information, you can render the chip inoperable. However, after you render the memory chip inoperable, the cartridge cannot be used in an HP product.

If you are concerned about providing this anonymous information, you can make this information inaccessible by turning off the memory chip’s ability to collect the product’s usage information.
To disable the usage information function
1. Touch the Setup icon on the Home screen.
   The Setup menu appears.
2. Touch Preferences.
3. Touch Cartridge Chip Info.
4. Touch OK.

**NOTE:** To re-enable the usage information function, restore the factory defaults.

**NOTE:** You can continue to use the cartridge in the HP product if you turn off the memory chip’s ability to collect the product’s usage information.

## Specifications

Technical specifications for the HP Photosmart are provided in this section. For complete product specifications, see the Product Data Sheet at [www.hp.com/support](http://www.hp.com/support).

### System requirements

Software and system requirements are located in the Readme file.

For information about future operating system releases and support, visit the HP online support Web site at [www.hp.com/support](http://www.hp.com/support).

### Environmental specifications

- Recommended operating temperature range: 15 °C to 32 °C (59 °F to 90 °F)
- Allowable operating temperature range: 5 °C to 40 °C (41 °F to 104 °F)
- Humidity: 20% to 80% RH non-condensing (recommended); 25 °C maximum dewpoint
- Non-operating (Storage) temperature range: −40 °C to 60 °C (-40 °F to 140 °F)
- In the presence of high electromagnetic fields, it is possible the output from the HP Photosmart may be slightly distorted
- HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise due to potential high electromagnetic fields

### Paper specifications

<table>
<thead>
<tr>
<th>Type</th>
<th>Paper weight</th>
<th>Paper tray</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Up to 20 lb. (up to 75 gsm)</td>
<td>Up to 125 (20 lb. paper)</td>
</tr>
<tr>
<td>Legal paper</td>
<td>Up to 20 lb. (up to 75 gsm)</td>
<td>Up to 125 (20 lb. paper)</td>
</tr>
<tr>
<td>Index cards</td>
<td>110 lb. index max (200 gsm)</td>
<td>Up to 40</td>
</tr>
<tr>
<td>Hagaki cards</td>
<td>110 lb. index max (200 gsm)</td>
<td>Up to 40</td>
</tr>
<tr>
<td>Envelopes</td>
<td>20 to 24 lb. (75 to 90 gsm)</td>
<td>Up to 15</td>
</tr>
<tr>
<td>5 x 7 inch (13 x 18 cm) Photo paper</td>
<td>145 lb. (236 gsm)</td>
<td>Up to 40</td>
</tr>
<tr>
<td>4 x 6 inch (10 x 15 cm) Photo paper</td>
<td>145 lb. (236 gsm)</td>
<td>Up to 40</td>
</tr>
<tr>
<td>8.5 x 11 inch (216 x 279 mm) Photo paper</td>
<td>145 lb. (236 gsm)</td>
<td>Up to 40</td>
</tr>
</tbody>
</table>

* Maximum capacity.
NOTE: For a complete list of supported media sizes, see the printer driver.

Print specifications
• Print speeds vary according to the complexity of the document
• Panorama-size printing
• Method: drop-on-demand thermal inkjet
• Language: PCL3 GUI

Scan specifications
• Image editor included
• Twain-compliant software interface
• Resolution: up to 1200 x 1200 ppi optical; 19200 ppi enhanced (software)
  For more information about ppi resolution, see the scanner software.
• Color: 48-bit color, 8-bit grayscale (256 levels of gray)
• Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Copy specifications
• Digital image processing
• Maximum number of copies varies by model
• Copy speeds vary according to the complexity of the document and model
• Maximum copy enlargement ranging from 200-400% (depends on model)
• Maximum copy reduction ranging from 25-50% (depends on model)

Cartridge yield
Visit www.hp.com/go/learnaboutsups for more information on estimated cartridge yields.

Print resolution
To find out about the printer resolution, see the printer software.

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for recycling has been incorporated into this product. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment Web site at: www.hp.com/hpinfo/globalcitizenship/environment/index.html

This section contains the following topics:
• Eco-Tips
• Paper use
• Plastics
• Material safety data sheets
• Power consumption
• Recycling program
• HP inkjet supplies recycling program
• Disposal of waste equipment by users in private households in the European Union
• Chemical Substances
• Toxic and hazardous substance table
Battery disposal in the Netherlands
Battery disposal in Taiwan
Attention California users
EU battery directive

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-Tips below to help you focus on ways to assess and reduce the impact of your printing choices. In addition to specific features in this product, please visit the HP Eco Solutions web site for more information on HP’s environmental initiatives.
www.hp.com/hpinfo/globalcitizenship/environment/

Your product's Eco features
• Smart Web printing: The HP Smart Web Printing interface includes a Clip Book and Edit Clips window where you can store, organize, or print clips you have gathered from the Web.
• Energy Savings information: To determine the ENERGY STAR® qualification status for this product, see “Power consumption” on page 52.
• Recycled Materials: For more information regarding recycling of HP products, please visit: www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and partners with some of the largest electronic recycling centers throughout the world. HP
conserves resources by reselling some of its most popular products. For more information regarding recycling of HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

**HP inkjet supplies recycling program**

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more information, go to the following Web site:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/
Disposal of waste equipment by users in private households in the European Union

This symbol on the product or its packaging indicates that the product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. More information about where you can drop off your waste equipment for recycling free of charge is available at your local city office, household waste disposal service or the shop where you purchased the product.

Evacuación de equipos usados por los usuarios en viviendas particulares en la Unión Europea

Este símbolo en el producto o en su embalaje indica que el producto no debe ser eliminado junto con los residuos domésticos. En su lugar, es su responsabilidad eliminar los equipos de forma adecuada, entregándolos en un punto de recogida designado para el reciclaje de aparatos eléctricos y electrónicos. Para más información acerca de donde puede depositar su equipo eléctrico para su reciclaje gratuitamente, visite su oficina municipal local.

Eliminazione di apparecchiature usate da parte degli utenti di abitazioni private nell'Unione Europea

Questo simbolo sul prodotto o sulla sua confezione indica che il prodotto non deve essere smaltito insieme ai rifiuti domestici. È responsabilità dell'utente smaltire il prodotto smaltendolo presso un punto di raccolta designato per il recupero di apparecchiature elettriche ed elettroniche. Per ulteriori informazioni sul modo di smaltire il prodotto, vada alla sua ufficina comunale locale o al negozio dove ha acquistato il prodotto.
Battery disposal in the Netherlands

Dit HP Product bevat een lithium-manganese-dioxide batterij. Deze bevindt zich op de hoofdprintplaat. Wanneer deze batterij leeg is, moet deze volgens de geldende regels worden afgevoerd.

Battery disposal in Taiwan

Please recycle waste batteries.

Attention California users

The battery supplied with this product may contain perchlorate material. Special handling may apply. For more information, go to the following Web site:

www.dtsc.ca.gov/hazardouswaste/perchlorate
EU battery directive

This product contains a battery that is used to maintain data integrity of real time clock or product settings and is designed to last the life of the product. Any attempt to service or replace this battery should be performed by a qualified service technician.

Directive sur les batteries de l'Union Européenne

Ce produit contient une batterie qui permet de maintenir l'intégrité des données pour les paramètres du produit ou l'horloge en temps réel et qui a été conçue pour durer aussi longtemps que le produit. Toute tentative de réparation ou de remplacement de cette batterie doit être effectuée par un technicien qualifié.

Batterie-Richtlinie der Europäischen Union

Dieses Produkt enthält eine Batterie, die dazu dient, die Datentreue der Echtzeituhr sowie der Produktinstellungen zu erhalten, und die für die Lebensdauer des Produkts ausreicht. Im Bedarfsfall sollte das Innendrehen bzw. Austauschen der Batterie von einem qualifizierten Service-Techniker durchgeführt werden.

Direttiva dell'Unione Europea relativa alle batterie e accumulatori

Questo prodotto contiene una batteria utilizzata per preservare l'integrità dei dati dell'orologio in tempo reale o delle impostazioni del prodotto e la sua durata si intende pari a quella del prodotto. Eventuali interventi di riparazione o sostituzione della batteria devono essere eseguiti da un tecnico dell'assistenza qualificato.

Direktiva Unii Européene referitorie la baterii

Acest produs conține o baterie care este utilizată pentru a menține integritatea datelor ceasului de timp real sau setărilor produsului și care este proiectată să funcționeze pe întreaga durată de viață a produsului. Orice lucrare de service sau de înlocuire a acestei baterii trebuie efectuată de un tehnician de service calificat.
Regulatory notices

The HP Photosmart meets product requirements from regulatory agencies in your country/region. This section contains the following topics:

• Regulatory model identification number
• FCC statement
• VCCI (Class B) compliance statement for users in Japan
• Notice to users in Japan about the power cord
• Notice to users in Korea
• Notice to users in Germany
• Noise emission statement for Germany
• HP Photosmart Plus e-All-in-One B210 series declaration of conformity

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is SNPRB-1001-01. This regulatory number should not be confused with the marketing name (HP Photosmart Plus e-All-in-One B210 series, etc.) or product numbers (CN216A, etc.).
FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)

The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by HP may void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

VCCI (Class B) compliance statement for users in Japan

この装置は、クラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。取扱説明書に従って正しい取り扱いをして下さい。
Notice to users in Japan about the power cord

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。

Notice to users in Korea

Notice to users in Germany

Sehanzeige-Arbeitsplätze
Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß BildschirmVorgesehen.

Noise emission statement for Germany

Geräuschemission
LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19
DECLARATION OF CONFORMITY
according to ISO/IEC 17050-1 and EN 17050-1

DoC #: SNPRB-1001-01-RevA

Supplier’s Name: HewlettPackard Company
Supplier’s Address: 138 Depot Road, #02-01, Singapore 109683

declares, that the product
Product Name and Model: HP Photosmart Plus All-in-One Series - B210
Regulatory Model Number: SNPRB-1001-01
Product Options: All
Radio Module: RSVD-0707 (802.11g/b)
Power Adapter: 0957-2271

conforms to the following Product Specifications and Regulations:

EMC:
- EN 301 489-1 V1.8.1:2008-04 / EN 301 489-17 V.1.3.2:2008-04
- IEC 61000-3-2:2000 / EN 61000-3-2:2000
- FCC CFR 47 Part 15 Class B / ICES-003, Issue 4

Safety:

Telecom:
- EN 300 328 V1.7.1:2006-05

Energy Use:
- Regulation (EC) No. 1275/2008
- ENERGY STAR® Qualified Imaging Equipment Operational Mode (OM) Test Procedure
- Regulation (EC) No. 278/2009

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.


Additional Information:
1) This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the design. The Regulatory Model Number is the main product identifier in the regulatory documentation and test reports, this number should not be confused with the marketing name or the product numbers.

Singapore,
December 11, 2009
Hou-Meng Yik, Manager
Product Regulations Manager
Customer Assurance, Business Printing Division

Local contact for regulatory topics only:
EMEA: HewlettPackard GmbH, HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, Germany

www.hp.com/go/certificates

Regulatory wireless statements
This section contains the following regulatory information pertaining to wireless products:
Exposure to radio frequency radiation

Caution
The radiated output power of this device is far below the FCC radio frequency exposure limits. Nevertheless, the device shall be used in such a manner that the potential for human contact during normal operation is minimized. This product and any attached external antenna, if supported, shall be placed in such a manner to minimize the potential for human contact during normal operation. In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximity to the antenna shall not be less than 20 cm (8 inches) during normal operation.

Notice to users in Brazil

Aviso aos usuários no Brasil
Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando em caráter primário. (Res. ANATEL 282/2001).

Notice to users in Canada

Notice to users in Canada/Note à l’attention des utilisateurs canadiens
For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissions from the digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications. The internal wireless radio complies with RSS 210 and RSS GEN of Industry Canada.

Utiliser à l’intérieur. Le présent appareil numérique n’émet pas de bruit radioélectrique dépassant les limites applicables aux appareils numériques de la classe B prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada. Le composant RF interne est conforme à la norme RSS-210 and RSS GEN d’Industrie Canada.
**European Union Regulatory Notice**

Products bearing the CE marking comply with the following EU Directives:
- Low Voltage Directive 2006/95/EC
- EMC Directive 2004/108/EC

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter provided by HP.

If this product has telecommunications functionality, it also complies with the essential requirements of the following EU Directive:
- R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to harmonized European standards (European Norms) that are listed in the EU Declaration of Conformity issued by HP for this product or product family. This compliance is indicated by the following conformity marking placed on the product.

The wireless telecommunications functionality of this product may be used in the following EU and EFTA countries:
Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland and United Kingdom.

**Products with 2.4-GHz wireless LAN devices**

**France**
For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This product may be used indoor for the entire 2400-2483.5 MHz frequency band (channels 1-13). For outdoor use, only 2400-2454 MHz frequency band (channels 1-9) may be used. For the latest requirements, see http://www.art-telecom.fr.

**Italy**
License required for use. Verify with your dealer or directly with the General Direction for Frequency Planning and Management (Direzione Generale Pianificazione e Gestione Frequenze).
低功率電波輻射性電機管理辦法

第十二條
經型式認證合格之低功率射頻電機，非經許可，公司、商號或使用者均不得擅自變更頻率、加大功率或變更設計之特性及功能。

第十四條
低功率射頻電機之使用不得影響飛航安全及干擾合法通信；經發現有干擾現象時，應立即停用，並改善至無干擾時方得繼續使用。

前項合法通信，指依電信法規定作業之無線電通信。低功率射頻電機須忍受合法通信或工業、科學及醫藥用電波輻射性電機設備之干擾。
Index

Symbols/Numerics
10 x 15 cm photo paper
  specifications 50

A
after the support period 47

B
buttons, control panel 8

C
control panel
  buttons 8
  features 8
  copy
    specifications 51
  customer support
    warranty 47

E
enetration
  WEP key 39
  envelopes
    specifications 50
  environment
    Environmental product stewardship program 51
    environmental
      specifications 50

I
interface card 35, 36

L
labels
  specifications 50
  legal paper
    specifications 50
  letter paper
    specifications 50

N
network
  interface card 35, 36
  security 39

P
paper
  specifications 50
  phone support 46
  phone support period
    period for support 46
  photo paper
    specifications 50
  print
    specifications 51

R
recycle
  ink cartridges 53
  regulatory notices
    regulatory model
      identification number 57
    wireless statements 60

S
scan
  scan specifications 51
  security
    network, WEP key 39
    troubleshoot 39
  system requirements 50

T
technical information
  copy specifications 51
  environmental
    specifications 50
  paper specifications 50
  print specifications 51
  scan specifications 51
  system requirements 50
  transparencies
    specifications 50

W
warranty 47
  WEP key, setup 39